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1. UVOD

Ovaj prirucnik je razvijen uz obuku drzavnih sluzbenika u podrucju informacijskih tehnologija
za naprednu primjenu Excela. Obuka je bila namijenjena djelatnicima koji u svom radu
upotrebljavaju Excel i Zele prosiriti svoja znanja radi $to brzeg i ucinkovitijeg obavljanja
svakodnevnih zadataka. Realizirana je u 15 nastavnih jedinica metodom predavanja,
demonstracije i rjeSavanjem primjera uz dodatna pojasnjenja i savjete. Nakon obuke i uz
primjenu ovog priru¢nika ocekuje se kako ée sudionici biti sposobni:

- primijeniti napredne moguc¢nosti oblikovanja

- vrednovati i nadzirati valjanost unosa podataka u tablicu

- izvoditi proracune pomocu odredenih matematickih, statistickih i funkcija
pretrazivanja

- prilagoditi izgled grafikona svojim potrebama

- analizirati podatke

- poboljsati produktivnost rada

- primijeniti znacajke sigurnosti u radu

2. OBLIKOVANIJE CELIJA I TABLICE

2.1. Automatsko oblikovanje ¢elija i tablice

U svrhu povecavanja preglednosti, lakSeg koristenja i bolje vizualne prezentacije Excel nudi
mogucnost oblikovanja éelija po unaprijed definiranim predloscima, koje korisnik moze po
Zelji i izmijeniti.

Primjena automatskog oblikovanja/stila tablice na raspon éelija

- odabrati ¢elije koje Zelimo oblikovati

- Polazno (Home) -> Stilovi (Styles) ->Oblikuj kao R — CISEE
( ) (Styles) : | Gl == e i T
F(:r:%\;‘nnﬂa\ ormat Cell [HS.ER Dﬂvﬂte Fnrvmat 2 Clear - E&Ergf ;T:‘tﬁi

tablicu (Format as Table) oA S

- odabrati Zeljeni stil ——

2.2. Uvjetno oblikovanje

Ponekad je podatke potrebno oblikovati na nacin da se

oblikovanje mijenja ovisno o nekom uvjetu koji je prije

zadan. Moguce je npr. drugom bojom istaknuti

odredene brojeve koji imaju posebno znacenje u tablici
(npr. temperature vise od prosjecnih).

Kako bi se primijenilo uvjetno oblikovanje potrebno je:
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- Oznaditi ¢elije, odnosno raspon ¢elija nad kojima se Zeli primijeniti uvjetno oblikovanje
- Polazno (Home) -> Stilovi (Styles) -> Uvjetno formatiranje (Conditional Formating)

- Odabrati Zeljeno uvjetno oblikovanje.

Ako Zelimo istaknuti temperature vise od prosjecnih, tada je potrebno oznaciti tablicu s
podacima te kliknuli na ,Vece od” gdje bi bilo potrebno unijeti vrijednost prema kojoj ¢e se

vrsiti usporedba, a onda odabrati i boju kojom Zelimo da te ¢elije budu obojane.

P =%
] ] mu| L. P ¥ AutoSum i
General . f:i ﬁi D || e 5o % C?a
Sy o |5 O (A 3 i -
ter~ || % = % o [[%5 ;%8| [Ceonditional| Format Cell Insert Delete Format Sort & Find &
= Ll | Formatting ~' as Table = Styles ~ - - - 2 Clear ~ Filter = Select -
(P Number P} I Editing
—1) Highlight Cells Rules » —"}I Greater Than... w
b=, = ¥
J K ] | R 5 T U
E=T)) Top/Bottom Rules 3 _‘I< Less Than...
= =
EJ Data Bars 3 :—lj Between...
= |
—=1| Color Scales 3 =4 Equal To...
1= |
1= Icon Sets 3 __Ib Text that Contains...
— —al
= Mew Rule...
b | = —_"% A Date Occurring...
#) | Clear Rules p |
j Manage Rules... =
=1 Duplicate Values... =
More Rules...

2.3. Prilagodeno oblikovanje brojeva

Primjenom razlicitih oblika brojeve je moguce prikazati kao postotak, datum, valutu, itd.

LY E T T e R 5 00< T NSO S|
]

—/ Home Insert Page Layout Formulas Data Review View Autodesk Vault

= Cut o=

j # Calibri 1 - A A F= gll?}"| =) Wrap Text General =
- =3 Copy e A : aikoellie
aste - || - - = = === EE| | b - - o e

- Format Painter |B L O~ Il ||| = =||:= £=|| = Merge & Center - | | § e v || %50 598 5

Clipboard (F] Font (] Alignment (F] MNumber @
= .
Al . f |
A B C D E F G H 1 J K L

Potrebno je oznaditi celije koje se Zeli oblikovati

- Polazno (Home) = Broj (Number)

pa onda odabrati:

- Kliknuti na Pokretac dijaloskog okvira pokraj opcije Number (u donjem desnom kutu)
- Na popisu Kategorija (Category) kliknuti oblik koji Zelimo koristiti, a zatim podesiti

postavke po potrebi.

NAPOMENA: Do dijaloskog okvira moguce je doci i desnim klikom misa na oznacene Celije.



3. PRIKAZ PODATAKA

3.1. Kopiranje i premjestanje radnih listova

Radna knjiga (datoteka s nastavkom .xlsx) sadrzi viSe radnih listova. Ako Zelimo premjestiti ili
kopirati radne listove potrebno ih je odabrati na nacin da kliknemo lijevom tipkom misa na
njihovu karticu (na kojoj se nalazi ime lista). Kod oznacavanja viSe listova primjenjivati
uobic¢ajena pravila pomocu tipki Shift i Ctrl. Ako Zelimo sve listove oznaditi koristimo
moguénost Oznaci sve (Select All Sheets) iz brzog izbornika kojeg pozivamo desnom tipkom
misa na karticu bilo kojeg lista. Najjednostavniji nacin za kopiranje ili premjestanje radnih
listova jeste pomodu brzog izbornika (desni klik na karticu) u kojem se nude opcije Premjesti
ili kopiraj (Move or Copy).

r -
Move or Copy &Iﬂ_hJ

13 Move selected sheets
14 Insert... To book:
15 Delete Book1 IEI
16
- Rename Before sheet:

Llove or Copy... .
18 "

G| View Code list1 (2)
19 list2 (2)
20 i | list3 (2)
21 Tab Color 3 :istl
. ist3

22 Hid

L[l (move to end)
23 -
24 Select All Sheets [7] create a copy
25

Ungroup Sheets E
4 M| fist2 | lislaymy w2}~ liSEl - liSt3 - ¥ [ oK l ’ Cancel
Beady

Odabirom Zeljene radnje otvara se dijaloski okvir za odabir mjesta na koje Zelimo premjestiti
radni list, u postojec¢oj radnoj knijizi ili nekoj drugoj koja je otvorena. Organiziranje radnih
listova (premjestanje, preimenovanje, pa ¢ak i promjena boje kartice) moze se pozvati i na
nacin Polazno (Home) -> Celije (Cells) -> Oblikovanje (Format).

NAPOMENA: Kada stvorite kopiju radnog lista, stvara se duplikat radnog lista u odredisnoj
radnoj knjizi. Kada radni list premjestite, on se uklanja iz izvorne radne knjige i pojavljuje se
samo u odredisnoj radnoj knjizi. Kada brisemo radni list program od nas traZi potvrdu jer
jednom izbrisan radni list ne moZe se povratiti.

3.2. Skrivanje i otkrivanje redaka, stupaca, radnih listova

Skrivanje jednog ili visSe redaka ili stupaca je najjednostavnije pomocu brzog izbornika kojeg
pozivamo desnim klikom misa nad oznacenim retcima ili stupcima koje Zelimo sakriti. Iz
izbornika biramo opciju Sakrij (Hide). Drugi nacin je odabrati Polazno (Home) -> Celije (Cells)
-> Oblikuj (Format) pa opciju Sakrij stupac (Hide Column) ili Sakrij redak (Hide Rows ) u
odjeljku Vidljivost (Visibility).



Za otkrivanje skrivenih redaka ili stupaca potrebno je oznaciti oba susjedna retka ili stupca pa
onda odabrati opciju Otkrij (Unhide) ili iz brzog izbornika ili iz odjeljka Vidljivost (Visibility).

Poseban slucdaj je otkrivanje skrivenog prvog stupca ili prvog retka, jer u tom sluéaju ne
mozemo selektirati oba susjedna retka ili stupca. U tom slucaju je potrebno na drugi nacin
oznaciti redak ili stupac koji Zelimo otkriti. Najjednostavnije je u okvir naziva celije upisati Al
i pritisnuti tipku Enter. Nakon toga idemo na otkrivanje stupca ili retka pomoc¢u Polazno
(Home) -> Celije (Cells) -> Oblikuj (Format) = Otkrij stupac (Unhide Column) ili Otkrij redak
(Unhde Rows ) u odjeljku Vidljivost (Visibility).

Za skrivanje radnih listova odabrati Zeljene listove te zatim u kartici Polazno (Home) -> Celije
(Cells) -> Oblikuj (Format). U odjeljku Vidljivost (Visibility) kliknuti na Sakrij list (Hide Sheet).

] 0 || == == ¥ AutoSum = A 5
+
R ol o €S T g
hat  Cell || Insert Delete Format| | Sort & Find &
ble - Styles ~ - - - o2 Clear ™ Filter ~ Select =

Cells | e size

30 Row Height.

AutoFit Row Height -

N o 1 Column Width.. s T =
AutoFjt Column Width ] 11
Default Width...

Visibility Insert...
Hide & Unhide > Hide Rows = Delete

Organize Sheets Hide Columns 16 8

Rename Sheet Hide Sheet 17
18 G view Code

19 [}y Protect Sheet...

Move or Copy Sheet... Unhide Rgws

Tab Color » Unhide Columns
Protection
iy Protect Sheet. 3 22

4| LockCell 23 I
Select All Sheets

% Format Cells... 14 b W[ Sheetl . Sheet? | Shwers—r=r=

Ready

Drugi, ujedno i jednostavniji nacin jeste pomocu brzog izbornika kojeg pozivamo desnim
klikom misa na oznaceni radni list, u kojem biramo opciju Sakrij (Hide) ili Otkrij (Unhide).

Za otkrivanje Polazno (Home)-> Celije (Cells) -> Oblikuj (Format). U odjeljku Vidljivost
(Visibility) kliknuti na Otkrij list (Unhide Sheet). U okviru Otkrivanje (Unhide) odabrati naziv
skrivenog lista kojeg Zelite prikazati.

NAPOMENA: Kod skrivanja radnih listova treba voditi racuna o tome da istovremeno moZete
sakriti vise radnih listova, ali moZete otkriti samo svaki list zasebno.

3.3. Podjela prozora

Podjela prozora olakSava rad s velikim tablicama i prikazom puno podataka na jednom
radnom listu. Standardna podjela koju Excel implementira je podjela prozora na 4 dijela.
PostiZe se tako da se odabere Prikaz (View) -> Prozor (Window) -> Podijeli (Split). Ponovnim
klikom na Podijeli se uklanja podjela. Inace, svi alati za upravljanje izgledom prozora u kojima
se otvara datoteka nalaze se u ovom odjeljku Prozor (Window) alatne trake Prikaz (View).



iew View Autodesk Vault

- Q0 E D Emed |

s [T ™= ' Hide
Zoom 100% Zoomto Mew  Arrange Freeze
Selection || Window Al Panes~ _J Unhide | |
Zoom

Za proizvoljnu vodoravnu i vertikalnu podjelu na 2 dijela najlakse je koristiti trake podjele koje
se nalaze na pomic¢nim trakama prozora i to:

. O‘" Traka za okomitu podjelu nalazi se desno od klizaca
— za vodorani pomak.
D |_.-!-._|
W

Traka za vodoravnu podjelu nalazi se iznad klizaca za
okomiti pomak.
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Traku podjele mozemo premjestati prema zelji tako da ju lijevom tipkom misa odvuéemo na
Zeljeno mjesto.

3.4. Kako ,zamrznuti“ dio tablice?

Mogucnost 'zamrzavanja' dijelova tablice najceSc¢e se primjenjuje na prvi redak (zaglavlje) ili
prvi stupac tablice. Na alatnoj traci Pogled (View) na kartici Prozor (Window) potrebno je
odabrati opciju Zamrzni okna (Freeze Panes). Ovisno od toga S$to Zelimo zamrznuti biramo:

Freeze First Row — zamrzni prvi redak
Freeze First Column — zamrzni prvi stupac

Freeze Panes — zamrzni okna (u ovom slucaju oznac¢imo samo ¢eliju koja se nalazi ispod i
desno od celija koje Zelimo zamrznuti)

% ;El E S;.:ulit 1 View Side by Side %

... Hide 44} Synchronous Scrolling

Arrange | Freeze L : Save 3
W All |Panes -] Unhide | A4 Reset Window Position Workspace Wi

Freeze Panes

Keep rows and columns visible while the rest of
the worksheet scrolls (based on current selection).
Freeze Top Row P
Keep the top row visible while scrolling through
the rest of the worksheet,

Freeze First Column

Keep the first column visible while scrolling
through the rest of the worksheet.

el e e




4. UNOS I PORUKE O POGRESKAMA

4.1. Vrednovanje unosa podataka
Za vrednovanje podataka koji se unose u tablicu potrebno je:

- Oznaditi zeljeni raspon celija

- Odabrati Podatci (Data) = Alati podataka (Data Tools) = Provjera valjanosti
podataka (Data Validation)

- Odrediti Kriterij vrednovanja (Validation Criteria)

- e —

| Input Message | Error Alert |

Validation criteria

Allowe:

|.|!'u-13.I value |E| Ignore blank
Data:

|I:uetween - |

Apply these changes to all other cells with the same settings

—

Postavljena validacija uklanja se u istom dijaloSkom okviru klikom na O¢isti sve (Clear All).

4.2. Ulazna poruka i poruka o pogresci

Excel nam u istom dijaloSkom okviru (Data Validation) nudi moguénosti postavljanja ulaznih
poruka za korisnike i upravljanja porukama o pogresci pri unosu. Ove poruke mogu biti od
koristi ukoliko Zelimo korisnika nasih tablica jasno uputiti na nacin unosa podataka u njih.

Settings | Error Alert |

Show input message when cell is selected Show error alert after invalid data is entered

When cellis selected, show this input message: When user enters invalid data, show this error alert:
Title: Style: Title:

| Stop :l |

Input message: Error message:

)




Vrste poruka o pogreskama su sljedede: =
Stani (Stop) — zaustavlja i sprjecava neispravan unos
Upozorenje (Warning) — Upozorava da je unos neispravan, ali ga ne sprjecava

Informacija (Information) — Obavjestava da uneseni podatci nisu valjani, ali ne ..0.'
sprjecava unos

4.3. Uporaba komentara

Komentari su dodatna pojasSnjenja sadrzaja u ¢elijama. Radnje koje se mogu izvesti s
komentarima su: umetanje/brisanje, uredivanje te prikazivanje/skrivanje. Sve potrebno za
navedene radnje nalazi se na traci Pregled (Review) i kartici Komentari (Comments).

zgled stranice Faorrmule Podaci Pregled Prikaz Teal

\ﬁ ﬂ *‘;\_J Lia i) PrikaZi/sakrij komentar

3 PrikaZi sve komentare

Uredi  Izbridi Prethodni Sljededi == — - Zai
komentar i PrikaZi rukopis li
Komentari
I
| c D
I 1 |Prazna celija
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5. FORMULE I FUNKCIJE

”63\ Bl i |

Home Insert Page Layout Formulas Data Review View De

fF T 0 BE®AE 0 @ @
Insert AutoSum Recently Financial Logical Text Date& Lookup & Math More

Function ¥ Used ~ % % > Time ~ Reference » & Trig ¥ Functions
Function Library

Formule i funkcije su temelj proracunskih tablica. Njihov unos pocinje upisivanjem znaka
jednakosti (=). Funkcije su unaprijed definirane formule za racunanje pomodéu odredenih
vrijednosti koje se zovu argumenti, u nekom to¢no zadanom redoslijedu ili strukturi.

One su dostupne na alatnoj traci Formule (Formulas), a moZzemo ih pronaci i pritiskom na
gumb (fx) na traci formule. Odabirom Zeljene funkcije se otvara pomocni prozor pomocu kojeg
odredujemo pojedine argumente. (Okvir za odabir funkcije se otvara i kombinacijom tipki
Shift + F3.)

Primjer pomoénog prozora za funkciju COUNTIF:

r N
Function Arguments ? &
COUMTIF
Range =
Criteria =

Counts the number of cells within a range that meet the given condition.

Range is the range of cells from which you want to count nonblank cells.

Formula result =

Help on this function [ QK l ’ Cancel ]

Argumenti mogu biti: brojevi, tekst, logicke vrijednosti, adrese celija, operatori ili funkcije
(gotovi izrazi). Sve funkcije su grupirane po odredenoj logici ponasanja u: financijske, logicke,
tekstualne, vremenske (datum i vrijeme), funkcije pretrazivanja, matematicke, statisticke i
druge. Za svaku funkciju Excel nudi kratko pojasnjenje po odabiru (kada zadrzimo pokazivac
misa nad nazivom funkcije) ili u prozoru Argumenti funkcije (Function Arguments).

5.1. Primjena relativnih, apsolutnih i mijesanih adresa u formulama

U formulama se mogu koristiti dvije vrste adresa ¢elija: relativne i apsolutne. Relativne adrese
se u formulama automatski prilagodavaju novom mjestu kada se ¢elija koja sadrzi formulu

kopira. Na slici je prikazana promjena adresa celija u formuli koja je kopirana iz stupca A u
stupac B.
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1 20 30
2 30 60
3 10 100
a E:Mmzma! =B1+B2+53

Kada ne Zelimo da se adrese ¢elija u formuli koja se kopira mijenjaju onda koristimo apsolutne
adrese. Adrese Celija postaju apsolutne kada se ispred oznake stupca i retka stavi znak za dolar
(S), npr. SAS4. (Brza pretvorba relativnih u apsolutne adrese je pritisnuti tipku F4 kada je
oznacena celija koju koristimo u formuli). Na slici je prikazan primjer formule u kojoj je
kopiranjem sprije¢ena promjena adrese Al pri kopiranju formule iz C1 u ES.

ES - ( fe | =5A%175
A B C D E F
18 =$AS1*5
2 1
3 |5
4
5 :5.5.51*5!
6

MijeSane adrese su one koje su samo djelomi¢no apsolutne. Pri kopiranju éelije koja sadrzi
mijeSane adrese ¢elija mijenja se samo onaj dio adresa koji je relativan (bez znaka S).

TUTTLLTOTT CTOTdTy
c5 - fe | =A5/C$9
A B -
1 preracunavanje marke u euro
2 iznos u KM iznos u EUR
3 25 =A3/C59
4 50 =A4,/C59
5 1100 ] =A5/CS5 |
& 700 =AG,/C59
7 |1000 =A7/CS9
2 | 10000 =A8/C49
9 trenutnitecaj |1EUR= EI,EIE 1
10

5.2. Primjena 3-D referenci
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3D adresiranje sluZi za povezivanje podataka u formulama iz susjednih radnih listova.
Postupak je sljedeci:

- Oznaditi ¢eliju u kojoj ¢e se prikazati rezultat

- Odabrati potrebnu funkciju (npr. SUM)

- Pritisnuti oznaku prvog radnog lista u rasponu

- Oznaditi €eliju ili raspon ¢elija na tom listu koje sudjeluju u formuli
- Pritisnuti i drZati pritisnutom tipku Shift

- Pritisnuti oznaku zadnjeg radnog lista u rasponu

- Otpustiti tipku Shift i pritisnuti tipku Enter.

Primjer 3D adresiranja = SUM(Sheetl1:Sheet3!A1) je formula kojom se zbrajaju vrijednosti
c¢elije A1 na radnim listovima List1, List2 i List3.

J | =SUM(Sheetl:Sheet3!Al)
D E F G

5.3. Primjena matematickih funkcija
Matematicke (i trigonometrijske; Math & Trig) sluze za algebarske i trigonometrijske izracune.

Funkcije ROUND, ROUNDDOWN i ROUNDUP sluze za zaokruZivanje decimalnih brojeva, a
ponasaju se razlicito kako je prikazano na slici primjera (ROUNDUP — zaokruZivanje uvijek na
viSu; ROUNDDOWN - zaokruZivanje uvijek na nizu vrijednost)

1 Broj ZaokruZivanje Funkcija Rezultat

2 1895,7825 na dvije decimale =ROUNDUP(A2;2) 1895,79!
3 na cijeli broj =ROUNDUP(AZ2;0) 1896
a na stotice =ROUNDUP(A2;-2) 1900
1 Broj Zaokruzivanje Funkcija Rezultat

2 1895,7825 na dvije decimale =ROUNDDOWN(A2;2) 1895,?8!
3 na cijeli broj =ROUNDDOWN(AZ2;0) 1895
4 na stotice =ROUNDDOWN(A2;-2) 1800

Razlike u zaokruzivanju u odnosu na funkciju ROUND prikazane su na slici ispod.
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Broj

1895,7825 na dvije decimale 1895,78 1895,78
na cijeli broj 1896 1895
na stotice 1900 1800

ZaokruZivanje ROUND ROUNDDOWN ROUNDUP

1895,79
1896
1900

Funkcija SUMIF se koristi za zbrajanje vrijednosti u nekom rasponu koje zadovoljavaju

odredeni kriterij. Funkcija prima obvezno dva argumenta, a to su raspon celija na koje se
odnosi funkcija zbrajanja i kriterij u obliku broja, izraza, reference celije, teksta ili funkcije koji
definiraju koje ¢elije ¢e biti uzete u obzir pri izracunu.

Npr. ako Zelimo zbrojiti u rasponu A1:A35 sve vrijednosti koje su manje od 19, onda ce ta
funkcija glasiti =SUMIF(A1:A35; ,,<19“).

Opcenito funkcija SUMIF ima tri argumenta:

Raspon (Range) celija u kojima se nalazi uvjet

Kriterij (Criteria) ili uvjet koji odreduje koje ée Celije biti zbrojene
Raspon_zbroja (Sum_range) ili raspon Celija koje treba zbrojiti; ako nije naveden,
onda se zbrajaju sve Celije u rasponu (Range).

Primjer za primjenu sva tri argumenta:

Cc1 v & Je | =SUMIF(A1:A5;"jabuke";B1:B5)
A B - D E E
1 jabuke 18' 43!
2 kruske 20
3 |jJabuke 25
4 |\viSnje 85
5 |kruske 12

5.4. Primjena statistickih funkcija

Funkcija COUNTIF broji ¢elije u zadanom rasponu koje zadovoljavaju odredeni uvjet:

= COUNTIF [raspon (Range); kriteriji (Criteria)]
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D2 - | I | =COUNTIF|{A2:A6;"jabuke")
A B i D E

Proizvod HKoliéina Cijena

1

2 jabuke 18 12,90 kn 2_|
3 kruske 20

4 jabuke 25 13,00 kn

& visnje 85 18,00kn

6 Kruske 12 15,00 kn

Funkcija RANK prikazuje poloZaj broja u popisu brojeva =RANK(broj; ref; redoslijed), gdje je:
- Broj (Number) — broj u popisu Ciji se polozaj Zeli pronaci
- Ref (Ref) — raspon celija s popisom brojeva u kojem se treba odrediti polozaj
- Redoslijed (Order) — broj koji odreduje redoslijed, ako je izostavljen ili 0 onda je
redoslijed padajudi (silazni); ako je 1 onda je redoslijed rastudi (uzlazni).

D2 - fe | =RANK(C2;$C$2:5C$9;0)
A B C D
’ Ime Prezime  Brojbodova Rang uspjesnosti
2 |Marta Burazin 252] 6l
3 Vedran Horvat 251 7
4 Marko licic 315 1
5 Marija Martinko 145 8
6 Jasna Paunkaovic 299 4
7 Tvrtko Petric 300 3
g Dina Spajic 299 4
9 Zdravko Tihomirovic 314 2

5.5. Primjena funkcija referenci i pretraZivanja

Funkcije referenci (adresne) i pretraZzivanja daju informacije o podacima na odredenim
mjestima.

Funkcijama VLOOKUP i HLOOKUP pretraZzuju se zadane vrijednosti u odredenom rasponu
¢elija. Navedene funkcije gotovo su identi¢ne, razlikuju se jedino u obliku tablice u kojoj se
traze podaci. Funkcija VLOOKUP (Vertical Lookup) koristi se za pretrazivanje podataka po
zadanom stupcu, a HLOOKUP (Horizontal Lookup) za pretrazivanje podataka po zadanom
retku.
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A B C D E F G H |

ime | prezime  |IMBG adresa red. Br. |IMBG |adresa
Marko Markovié 100596844455 |Karlova 12 4 = - L 1 1102936444 I kovarska 35
Ivani lvié 7' 120796545666 ) 2| 1203337455 itska 15
Janko jankovic 502998465333 3 130494944435|Radiceva 13
Tomo Tomic 110695944427 4 230493444456 LjL:ilqina 23
Zoran Zoric 220594245632 5 150999944556 Breéé‘nova 34
Slaven Slavini¢ | | 707937465123 6 100596844455 |Karlova 12
Jure Juric¢ 810964465111 7 220254244467 | Zvonimirova 14
8 110293444456|Zagrebacka 11
) \ P 9]  220797844456|Vukaovarska 25
1 ) ' 10 110197844456 |Splitska 20
f 2 11 120796545666 |Radiceva 23
12 310896743561 |Ljubina 12
I 13 240397844435 |Bresanova 14
i 14 707937465123 |Karlova 19
1 15 110393244456 |Zvonimirova 15

Funkcija VLOOKUP je ceS¢a u uporabi jer su podatci u tablicama najcesée vertikalno
postavljene, tj. sa zaglavljem na vrhu tablice. Ova tablica ima 3 +1 argumenta koja unosimo
na sljededi nacin:

S : : @ 52

Function Arguments

VLOOKLIP

i

ﬁ"l
]

Lookup_value
Table_array

Col_index_num

| [ (]
]

1

%‘1
[]

Range_lookup

Looks for a value in the leftmost column of a table, and then returns a value in the same row from a column you spedify.
By default, the table must be sorted in an ascending order,

Lookup_walue is the value to be found in the first column of the table, and can be a value, a
reference, or a text string.

Formula result =

Help on this function Ok ] I Cancel

Vrijednost_pretraZivanja (Lookup value) je zadana vrijednost koju treba pronadi u tablici
informacija, koja moze biti odredena vrijednost ili adresa celije ili raspon ¢elija (u slucaju na
slici gore to je raspon éelija B1:B8 jer za sve te JMBG trazimo adrese u drugoj tablici ili tablici
informacija)

Polje_tablice (Table_array) je tablica informacija u kojoj se traze podatci; potrebno je oznaciti
cijelu tablicu s prvim stupcem koji je zajednicki za obje tablice (u ovom slucaju to je stupac
JMBG)

Indeks_stupca (Col_index_num) je broj stupca oznafenog raspona celija iz kojeg ce biti
vracena trazena vrijednost (1 odgovara prvom stupcu, 2 drugom itd.)
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Raspon_pretraZivanja (Range_lookup) je logicka vrijednost koja odreduje hoce li se traZiti
identicna ili priblizna vrijednost (ako se izostavi onda program podrazumjeva TRUE
vrijednost).

FALSE ili 0 — identi¢na (to¢na) vrijednost

TRUE ili 1 — priblizna vrijednost

Preporuka je uvijek staviti FALSE!

NAPOMENE:
- U tablici informacija (table_array) selektirati uvijek prvi zajednicki stupac i sve stupce

desno od njega. To ne mora nuzZno biti prvi stupac u tablici pretrage.

- Vrijednost koju trazimo treba da je u tablici informacija u stupcu koji je desno od
zajednickog stupca. VLOOKUP funkcionira samo udesno, ali ne i ulijevo.

- Pri odabiru obvezno ukljuciti i nazive stupaca.

- Ako se funkcija kopira obvezno koristiti apsolutne adrese celija (znak S).

- Col_index_num se uvijek broji od zajednickog stupca udesno.

- Za pravilan rad ove funkcije bitno je da tablica informacija u kojoj se traZe podatci sadrZi
jedinstvene vrijednosti zajednickog stupca. Kada bi se neki podatak pojavio vise puta i
to s razlicitim adresama, funkcija LOOKUP bi ,,pokupila” onu adresu koja je prva u tablici
a ostale zanemairila.

- Cesto se dogada da funkcija javi da nema odgovarajuce vrijednosti u tablici pretrage,
mada one tamo postoje. Najéesce se to dogada u slucajevima gdje su brojevi u jednoj
tablici formatirani kao tekst. Takvi brojevi jednako izgledaju, ali ih Excel tretira drukcije
i ne moZe ih povezati u pretrazi. Ovo je jedna od najcescih pogresaka koje treba

izbjegavati.

5.6. Primjena funkcija baze podataka

Funkcije u ovoj kategoriji pocinju slovom D (Database) i imaju svoje ekvivalente u obi¢nim
funkcijama (zbrajanje, prosjek, minimum, maksimum).

Funkcija DSUM zbraja brojeve, koji zadovoljavaju odredene uvjete, u zadanom stupcu (polju
baze podataka): = DSUM[baza_podataka(Database);polje(Field);kriteriji(Criteria)]
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TP OOdra . TUTIL " ATTTITT

G4 - ﬁ:| =DSUM(A4:D13,D4,B1:C2)
A B = D E F G
kriterij: |artikl cijena
kruske (<4
red. Br. |artikl cijena koligina DSUM= 20000
1|jabuke 2 12800
2|kruzke 3 10000
3|banane 4 85000
4|jabuke 3 390
5|3ljive 4 599
1] 6|kruske 4 15000
L 7|limun 5 600
P 8|banane 2 12000
9|kruske 2 10000

Npr. potrebno je izracunati ukupnu koli¢inu kruSaka na skladistu ¢ija je cijena manja od 4

KM. U ovom slucaju argumenti funkcije su redom:

Baza_podataka — cijela tablica s podatcima, tj. raspon A4:D13

Polje — adresa naziva stupca u kojem se nalaze podatci na koje se primjenjuje funkcija

(u ovom slucaju zbrajanje SUM) tj. D4

Kriterij — raspon ¢elija u kojima je definiran kriterij, tj. B1:C2 (ovdje treba paziti da nema

pogresaka u ispisivanju naziva, jer ¢e funkcija vratiti nulu za rezultat).

5.7. Nadziranje formula

Formule u Excel-u mogu sadrzavati prethodnike i mogu sluZiti kao zavisne drugim formulama.

Celija se ¢esto ponasa i kao prethodna i kao zavisna.

1
2
3
4
5
i)
7
B
9 |
10
11

12
12
14
15
16
17

A
Podruinica
Zagreb
split
Dubrovnik
Osijek
Rijeka
Zadar
Ukupna prodaja

Podruinica
Zagreb

split

Dubrovnik
Osijek

Rijeka

Zadar

Ukupni troskovi

B C D | E |
Ostvarena prodaja

50000 ¢
20000
33000
21000
36000
18000

=SUM(&
|

Dool =E»B17

Troskovi

Jooo ¢
2000
4000
3000
5000
1000

=suM(B11:B16)
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Prethodne i zavisne ¢elije se dobiju tako da se oznaci éelija za koju Zelimo provjeriti prethodne
i zavisne Celije te se po potrebi odabere Formule (Formulas)-> Kontrola formule (Formula
Auditing) -> Prati prethodnike (Trace Precedents) ili Formule (Formulas) -> Kontrola formule
(Formula Auditing)-> Prati ovisne elemente (Trace Dependents). Za uklanjanje strelica koristi
se Formule (Formulas)-> Kontrola formule (Formula Auditing) -> Ukloni strelice (Remove
Arrows).

% Trace Precedents 3] Show Formulas =
”if Trace Dependents ‘@} Error Checking - 'Jd
Watch

.. Remove Arrows - l& Evaluate Formula | wWindow

Formula Auditing

Pracenje pogreSaka -> ukoliko recimo u B8 zamijenimo B2 sa B3, automatski ¢e nestati
praéenje prethodnike te ¢e se pojaviti upozorenje o moguéoj gresci.

A | B C D E
1 PodruZnica Ostvarena prodaja
2 Zagreb ISDDDD
3 Split 20000
4 | Dubrovnik 33000
5 Osijek 21000
6 Rijeka 36000
7 Zadar | L3000
Elukupna prodaja  |<@: - F:SUM{Bﬁ-.B-?-}—-—._.___=_!_______
’ Formula izostavlja susjedne celije
10 |PodruZnica
11 7agreb Azuriranje formule da bi se ukljudile éelije
12 |split Pomod za ovu pogreiku
13 Dubrovnik Zanemari pogresku
14 |Osijek Uredivanje u traci Formula
15 Rijeka A : .

Moguénosti provjere pogresaka...

16 Zadar : y— :
17 Ukupni trogkovi =sumM(E11:B16)

Provjeru pogreSaka mozZete napraviti i preko Formule (Formulas) -> Kontrola formule
(Formula Auditing) -> Provjera pogresSaka (Error Checking) pri cemu se otvara dijaloski okvir
preko kojeg moZzemo dalje obraditi pogreske.
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B8 - £ | =sum(B3:87)

A | B | ¢ D E F G H
1 |Podruinica Ostvarena prodaja
2 |Zagreb 50000
3 |Split 20000
f Pogreska u celiji B3
4 |Dubrovnik 33000 (:g . ! i Azuriranje formule da bi se ukljudile celije :
5 Osijek 21000 =TLI(REST))
6 |Rijeka 36000 Formula izostavlja susjedne celije Pomoé za ovu pogresku
Formula u eliji odnosi se na raspon koji ima B =
7 |Zadar ,18000 dodatne brojejve susjedno od :j?;a. ’ Zanemari pogresku
8 |Ukupna prodaja [esumessn— |
q Uredivanje u trad s formulama
10 |Podruinica Troskovi S s
Moguénosti... Prethodno Sljedece
11 Zagreb 7000
12 |Split 2000
13 Dubrovnik 4000
14 |Osijek 3000
15 |Rijeka 5000
16 |Zadar 1000
17 |Ukupni trozkovi =sum(E11:816)

Sve formule mogu se prikazati na radnom listu, umjesto rezultata formula, na nacin da
odaberemo Formule(Formulas)->Kontrola Formule (Formula Auditing)=>PrikaZi Formule
(Show Formulas)

6. ANALIZA PODATAKA

Zl
6.1. Sortiranje £
il
Razvrstavanje ili sortiranje podataka u tablici sluZi za postizanje bolje preglednosti A
podataka. Postoje dvije vrste sortiranja u Excelu:
- brzo sortiranje (uzlazno ili silazno, prema vrijednosti)
- korisnicko sortiranje (po vise stupaca ili kriterija) ZA
Sort

Naredbu Sort moZemo pronaéi na alatnoj traci Podatci (Data), na alatnoj traci
Polazno (Home) ili u brzom izborniku (desni klik misa na celije).
Za sortiranje po vise kriterija potrebno je kliknuti na tablicu, pokrenuti naredbu Sort, pa u
dijaloSkom okviru Sortiranje (Sort) odrediti:

- po ¢emu Ce se podatci sortirati (Sort by)

- kako ¢e se sortirati (po sadrzaju ili oblikvoanju ¢elije) (Sort On)

- kojim redoslijedom (uzlazno, silazno...) (Order)

’ ‘-551 Add Level ] [ X Delete Lewvel ] [ 53 Copy Level ” @ E My data has headers

Column Sort On Order
Sortby | prui [=] |values [=] |atoz (=]
Thenby | drugi El Values El Largest to Smallest El
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6.2. Filtriranje

Filtriranje podataka pomaze lakSem pronalazenju odredenih podataka, posebno ako su u
pitanju vrlo velike tablice. Filtriranjem se ne mijenja sadrzaj ¢elija niti njihov raspored u tablici,
samo se privremeno skrivaju odredene celije po odredenim kriterijima.

Postoje dvije vrste filtriranja:

- automatsko — jednostavni kriteriji Godin ~ | Mjese ~ Regija |~

1%} sortatoz

- napredno — slozeniji kriteriji :
P y ) 1%l sortZtoa

Sort by Colar 3
Kod automatskog filtra postupak je sljededi: | d
- odabrati jednu od celija tablice ] ,
- ukljuditi automatski filter naredbom Filter ] Text Filters »
- uzaglavlju stupca pritiskom na strelicu otvoriti izbornik ] o ot AD
- odabrati kriterij filtriranja i:?:a'ﬂa
i ¥ Evropa
[+] Juzna Amerika
C 1 Sieverna Amerika
- | Hegija - | -
| fziia | c. . [

QK ][ Cancel ]

Zadavanje slozenijih i viSestrukih kriterija moguce je kod opcije napredno filtriranje
(Advanced). Ono zahtjeva odredivanje kriterija u novom rasponu ¢elija, odvojeno od popisa
koji se filtrira. Raspon kriterija ima najmanje dva retka: naslovi stupaca po kojima se tablica
filtrira i kriterij filtriranja.

Advanced Filter @lﬂ

Data Review View Autodesk Vault Action
L] connections 3l 'ﬁ ]_[_" {& Clear (@) Eilter the list, in-place
7z . _
27 Properties o i Reapply () Copy to another location
il Sort Filter T,
=2 Edit Links - Advanced List range: SAE1:E6E520
onnections Sort & Filter o —
Criteria range: |5B522: 51:523|
Copy to: £HS1:8.51 s

[7] unique records only
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6.3. Podzbrojevi (Subtotali)

Podzbrojevi ili Subtotali su proracuni za odredene skupine podataka. Za automatsko

izraCunavanje podzbrojeva potrebno je:

- razvrstati (sortirati) popis po stupcu prema kojem ce se podatci grupirati

- odabrati jednu od ¢elija tablice (kliknuti na tablicu)

- odabrati naredbu Podatci (Data) = Struktura (Outline) > Podzbroj (Subtotal)

l::}l‘ =
J _,_I | Show Dretail

= HldE Cretail
Gr::uup Ungroup Subtotal
Cutline lat
U dijaloskom okviru Subtotal treba odrediti postavke: r— R
- stupac po kojem se podatci grupiraju JR— I
- funkciju koja se primjenjuje u podzbroju Goding
. = -
(Sum, Average, Min...) Use function:
. . . . 1 |: Sum E|
- izbor stupaca na koje se odnosi funkcija _ =
. 2 Add subtotal to:
- ukljuciti/iskljuciti sazetak ispod podataka é 3 Eeodma -
- Mjesec
.. . . . - | 4 DRJegija
Strukturni prikaz ima u osnovi 3 razine, a ako BT 02
|
se rade dva subtotala na jednoj tablici onda B -
prikaz imai4 razine. o T | [V] Replace current subtotals
a [ page break between groups
r ~ Summary below data
I [ Remove All ] [ oK. ] [ Cancel
6.4. Pivot tablice =

Zaokretne tablice (Pivot table) ili stoZzerne tablice su poseban prikaz postojecih tablica koje
daju sazetak informacija iz odredenih polja (stupaca) popisa ili baze podataka. One sluze za
analizu podataka i omogucuju jednostavan i brz prikaz podataka u razlicitim oblicima.
Napravljena tablica moze se 'okretati' tako da stupci postanu retci i obrnuto pa otuda i naziv
‘zaokretna' tablica. Kriteriji za analizu podataka mogu se premjestati, dodavati i uklanjati.

Postupak stvaranja zaokretne tablice je sljededi:

- kliknuti na tablicu

- na alatnoj traci Umetanje (/nsert) odabrati u odjeljku Tablice (Tables) naredbu

PivotTable.

- udijaloskom okviru odabrati raspon tablice i mjesto na koje ¢e se smjestiti Pivot tablica

(naisti ili novi radni list).

22



IGA TR -
-

Home Insert
»JJ| PEEEE ‘ﬁ sl Podrugje
fPivot;fable! Table || Picture izgleda
| i3] PivotTable L zvjestaja
=2 e jpr— zaokretne
i] C w \ .
s i tablice
A B
NAPOMENE:

svaki stupac mora
imati zaglavlje, tj. naziv stupca

s

a

o - ‘T r_.l “
=
a H 4 .‘:n. Tabela Furkd Lt -
oot Ao o ok 1 g
Tior busid @ vwpeet. Chacas Bakin bam ::.
e Frvol Tabile Fwid Lt Frd
_____ Sekcija |
polja N
g demicly Srtemar. ares e
o e 1 ot Lty
Sekcija | Buwes 5 ws
izgleda
Dfer Lot Lipdaie
[, [

ne smije biti praznih redaka niti stupaca unutar tablice
ne smiju biti nikakve spajane celije (Merge Cells)
ne smiju bti skriveni retci ili stupci (Hidden Row/Column

ne smije biti nikavih totala ni subtotala u tablici

7. GRAFIKONI

7.1. Promjena vrste grafikona

Za kreiranje grafikona poznato je da treba oznaditi ona podrucja tablice koja Zelimo prikazati

graficki. To moze biti cijela tablica ili samo neki dijelovi. Nakon oznacavanja na alatnoj traci
Umetanje (/nsert) biramo karticu Grafikoni (Charts) i na njoj zeljeni tip grafikona.
Za promjenu vrste veé kreiranog grafikona ponovno oznacimo podrucje grafikona i na alatnoj
traci Dizajn (Design) biramo karticu Vrsta (Type) i opciju Promjeni vrstu grafikona (Change
Chart Type). Brzi i jednostavniji nacin je pomocu okvira za dijalog koji se pojavi nakon sto smo
desnom tipkom misa kliknuli na grafikon pa odabirom opcije Promjeni vrstu grafikona

(Change Chart Type).
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Cut
Copy

Paste

Eont...

Reset to Match Style

Change Chart Type...

M.
SR  tfde

A

- Select Data...
T| & Move Chart.. Change Save As
T X Chart Type Template
& H_;_lJ Bring to Front » T}'pe

2y sendto Back »

Assign Macro...

ﬁf‘ Eormat Chart Area...

7.2. Kombinirani grafikoni i sekundarne osi

Kada mijenjamo vrstu grafikona samo jednom nizu podataka dobijemo kombinirani grafikon.
Kombinirani grafikon moZe npr. imati jedan niz podataka prikazan linijski a drugi stupcéasto
(stupcasto-linijski). Koristimo ih za jasniji i pregledniji prikaz svih nizova podataka na jednom

grafikonu.
. _ _ _ 0000
red. br. |artikl cijena  |koligina 80000 A
1|jabuke 2| 12800 7o00e /\
— £0000 e
2|kruzke 3] 10000 / \
50000 v
3|banane al 85000 y \
40000 / \ I kolicina
4|jabuke 3 390 30000 4 —s D
5|5ljive 4 599 20000
6|kruske 4 15000 10000 - I I:[
7|limun 5 600 04 T T T T T
& 2 & R e & & 2
2 E:.Tﬁakr:ae i Eggg FIFETFT IS E

Ako se vrijednosti nizova podataka na grafikonu znatno razlikuju ili ako se rabi kombinirani
grafikon, jedan ili viSe nizova podataka mozZe se prikazati na sekumdarnoj okomitoj osi. Za
dodavanje sekundarne okomite osi potrebno je:

- oznaciti niz podataka koji Zelimo da se prikaze na sekundarnoj osi
- pozvati okvir za dijalog Oblikovanje niza podataka (Format Data Series)
- u okviru odabrati opciju Sekundarna os (Secondars Axis) u dijelu Series Options.

7.3. Oblikovanje elemenata grafikona

Za dodatno oblikovanje bilo kojeg elementa grafikona potrebno je oznaditi taj element pa na
alatnim trakama Oblikovanje (Format) ili lzgled (Layout) odabrati karticu Trenutni odabir
(Current Selection) i naredbu Oblikuj oznaceno (Format Selection).
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50000 6

80000
A s
70000

60000 # : ! 4 2 :
/ \ - Home Insert Bi
50000 / v \
3 G 0 | aapnd -
40000 I kolicina
30000 \_._ 3 2 | By, Format Selection
| I —4—cijena = }
— Reset to Match Style
20000 C —0 & |
Current Selection

-1
10000 4 I PR
[ -0

Za promjenu polozaja elemenata grafikona potrebno je oznaditi grafikon pa na kartici lzgled
(Layout) odabrati karticu Natpisi (Labels) te odabrati koji element i na koji nacin Zelimo
promijeniti:

- Naziv grafikona (Chart Title) = . . A

- Nazivi osi (Axis Titles) I} | . Il'—I| ,|i_|]| = |
- Legenda (Legend) Chart Axis Legend| Data | Data
- Natpisi nizova podataka (Data Labels) Title = Titles~  ~  |Labels =/ Table ~
- Tablica podataka (Data Table) Labels

8. POVEZIVANJE I UVOZ PODATAKA

8.1. Povezivanje podataka u Excelu

Podaci se mogu povezati na istom radnom listu, izmedu radnih listova, izmedu radnih knjiga
ili s datotekama drugih programa.

Povezivanje se moze izvrsiti:

- ruénim unosom formula,

- kopiranjem i lijepljenjem veze ili
- umetanjem hiperveze.

Povezivanje podataka na jednom radnom listu obavlja se adresama tj. formulama. Celija u
kojoj se nalazi formula povezana je s drugim celijama preko njihovih adresa.
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Jednako tako i podatci koji se prikazuju u
i . i . : SUM v K v f:':| =Al
grafikonu povezani su i ovise o podatcima
pripadajuée tablice. Svaka promjena u tablici 3 r":&"iﬂ B c 2
dovodi do promjene izgleda grafikona. s e &
Povezivanje podataka izmedu radnih listova u | 3 -A
ol

jednoj radnoj knjizi obavlja se isto tako
formulama s tim da je u ovom slucaju adresiranje ¢elija nesto drukcije jer se mora ukljuditi i
oznaka radnog lista na kojem se nalazi ¢elija koja se povezuje.

Npr. ako Zelimo da se na C3 (List2) ispisuje vrijednost ¢elije Al s prvog radnog lista potrebno

je: ipuodng e TUTIL
c3 - fx | =sheet1!a1

- odabrati ¢eliju C3 na radnom listu List2 i upisati

znak = d

., . . . . . 7 .. A B C D E
- pritisnuti oznaku Listl i odabrati éeliju Al 1
- potvrditi sa Enter ¢
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Povezivanje podataka izmedu radnih knjiga je vanjsko adresiranje pa uz oznaku radnog lista
u adresu ukljucuje i oznaku radne knjige s kojom se povezuje. To izgleda ovako:

- =[Knjigal.xlIsx]List1!A1l - ako je radna knjiga otvorena
- ='C:\Users\user_name\Dokumenti\[Knjigal.xlIsx]List1'!A1 — ako je radna knjiga
zatvorena.

Povezivanje podataka kopiranjem i lijepljem veze se obavlja tako da oD - 02020 |

se nakon kopiranja koristi opcija Zalijepi poveznicu (Paste Link) iz~ rene = o

izbornika Zalijepi (Paste) ili iz okvira za dijalog Posebno ljepljenje = [} % Calibri
53 Copy
(Paste SpECia/). IPEEtEI J Format Painter B
[ Paste L F
Hiperveza se postavlja na nekoliko nacina: [ Formulas S
.. . . . . Paste Values C
- upisivanjem to€ne web adrese ili npr. e-mail adrese o Borders
- naredbom Umetanje (/Insert) > Veze (Links) > Hiperveza Transpose
B Paste Link
(Hyperhnk) Jﬂ" Paste Special...
- precicom na tipkovnici Ctrl + K (jednako otvara dijaloski okvir @ | Paste as Hyperiink
. & As Picture 4
Insert Hyperlink) e

8
a
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P
Insert Hyperlink

Link to:

Existing File or
Web Page

Place in This
Document

Create Mew
Document

E-mail Address

Text to display: |
Look in: | | vieibe novo
£ 01_oblkovanje_2.xlsx -
%’E’:t 2] 01_oblkovanje_uradeno.xlsx E|
E31] 02_prikaz_2.xlsx
£ 02_prikaz_uradeno.xlsx
Browsed |&2] 03_vrednovanje_2.xlsx
Pages @,ﬁ 03_vrednovanje_uradeno.xlsx
21 04_funkcije_2.xlsx
Regent 2] 04_funkcie_uradeno.xsx
Files  |¥2] 05_nadziranje_formula_2.xlsx
&2 05_nadziranje_formul_uradeno.xlsx 2
Address: | |Z|
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8.2. Uvoz podataka iz tekstualne datoteke u tablicu

Jedan od nacina kako biste sebi olaksali unos veéeg broja podataka u tablicu jeste da te
podatke zapiSete u obi¢nu tekstualnu datoteku (.txt) a zatim ih uvezete u Excel.

Postupak je sljedeci:
- unijeti podatke (brojeve, rijeciili sl.) u tekstualnu datoteku tako da ih razdvajate
razmaknicom, tabulatorom, zarezom ili drugim razdjelnikom

u Excelu odaberete opciju Dohvaéanje vanjskih podataka (Get External Data) > Iz
teksta (From Text)

- u okviru Uvoz tekstualne datoteke odaberete postojeéu datoteku
- pritiskom na gumb Uvoz pokrece se ¢arobnjak koji vodi postupak uvoza podataka.

1
Text Import Wizard - Step 1 of 3 y [
The Text Wizard has determined that your data is Fixed Width.
If this is correct, choose Mext, or choose the data type that best describes your data.
= Original data type
[CWCRASSS - |
it Choose the file type that best describes your data:
- Home Insert Page Layout Formulas Data © - Characters such as commas or tabs separate each field.
= hi - Fields are aligned in columns with spaces between each field.
ol ol L ol 5 P! _g] Conne
= 5
= e =5 = =is 2 :
o em e e | e | Startimport at row: | 1 < File grigin: 437 : OEM United States
Access Web  Tet  Sources~ | Connections All~ == Edit Li
Get External Data Connections
5 - ( £ [ Preview of file C:\Users\zoki\Documentsiproba. bet.
|
| 1marija danijela marina gracijela zorica radmila -
(I}
2]
=] -
< [
\ = e —
— e

9. MJERE SIGURNOSTI I ZASTITA
PODATAKA

_/EI ,_L[]’% J &1 Protect and Share Workbook
s .

'3;,1 Allow Users to Edit Ranges
Unprotect  Protect Share
Sheet Workbook ~ Workbook _# Track Changes -
Changes

9.1. Dodavanje i uklanjanje lozinke za zastitu radne knjige

Zastita radne knjige lozinkom onemogucava samo promjenu strukture i izgleda radne knjige,
npr. sprje¢ava dodavanje ili uklanjanje radnih listova. Zastita se ne odnosi na sadrzaj radne
knjige. Kako bi se zastitila radna knjiga potrebno je na traci Pregled (Review) na kartici
Promjene (Changes) kliknuti na Zastiti radnu knjigu (Protect Workbook). U dijaloSkom okviru
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koji se pojavio treba unijeti lozinku. U okviru Potvrdi lozinku (Confirm Password) potrebno je
unijeti lozinku jo$ jednom radi potvrde.

Zastita radne knjige nudi dvije opcije:
- zaStitu promjene strukture i
- zastitu izgleda prozora radne knjige.

- : : ; :
Protect Structure and Windows &Iﬂ

Protect workbook: for

Structure
[ windows

Password {optional):

| ok || Cancal ]|p

Kako bismo uklonili zastitu radne knjige potrebno je ponovno kliknuti na Zastiti radnu knjigu
(Protect Workbook) i unijeti lozinku te ¢e time biti uklonjena zastita.

9.2. Dodavanje i uklanjanje lozinke za zaStitu radnih listova

Kako bismo zastitili sadrzaj éelija tj. radnih listova potrebno je na kartici Promjene (Changes)
kliknuti na Zastiti list (Protect Sheet). U dijaloSkom okviru treba unijeti lozinku i odabrati na
koji nacin Zelimo zastititi sadrzaj, tj. koje radnje nad sadrzajem Zelimo dopustiti.

- . . S

, .
Protect Sheet D[]

Protect worksheet and contents of locked cells

Fassword to unprotect sheet:

Allow all users of this worksheet to:
Fljselectlockedcells I8
[¥] select unlocked cells B
Format cells
Format columns
Format rows
Insert columns
Insert raws
Insert hyperlinks
Delete columns
Delete rows o7

m

OOEEEEEEE

Lozinku je potrebno jo$ jednom potvrditi, a uklanjanje zastite se radi tako Sto kliknemo na
Ukloni zastitu lista (Unprotect Sheet) i unesemo lozinku ¢ime ée i zastita biti uklonjena.
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9.3. Zastita celija, skrivanje formula

Zastita celja od promjena koje se mogu odnositi na unos, oblikovanje ili neke druge radnje
nad njima radi se na nacin da ozna¢imo samo one celije koje zZelimo zastititi, pa u dijaloSkom
okviru Oblikovanje éelija (Format Cells) na kartici Zastita (Protect) stavimo kvacicu ispred
Zaklju€ana (Locked) ili Skrivena (Hidden). Nakon toga je obvezno napraviti zastitu radnog lista
lozinkom (Protect Sheet).

[EE—— s

|Number I Alignment | Font I Border | Fill |

[ Locked
[ Hidden

Locking cells or hiding formulas has no effect until you protect the worksheet (Review tab, Changes
group, Protect Sheet button).

Opcija Skrivena (Hidden) Cesto se koristi za skrivanje prikaza formula koje se nalaze u ¢elijama.

Za svaku promjenu zastite celija potrebno je najprije ukloniti zastitu radnog lista pa onda
napraviti Zeljene izmjene zastite ¢elija.
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10. PRILOZI

Vjezba 1: Primjena prilagodenog i uvjetnog oblikovanja

- Otvorite datoteku 01_oblikovanje.xIsx

- Naradnom listu Automatsko_oblikovanje oblikujte tablicu primjenom stila tablice po
Zelji. Neka tablica ima zaglavlje.

- Preimenujte drugi radni list u Prilagodeno_oblikovanje

- Kopirajte uredenu tablicu na radni list Prilagodeno_oblikovanje pa u rasponu C2:C30
izradite prilagodeni oblik tako da su brojevi prikazani s jednom decimalom i odvojenom
tisuéicom.

- Preimenujte tredi radni list u Uvjetno_oblikovanje i na njega preslikajte tablicu s drugog
radnog lista. U rasponu C2:C30 zelenom bojom istaknite pet najvisih vrijednosti, a
crvenom bojom pet najnizih vrijednosti.

- Spremite promjene i zatvorite datoteku.

Vjezba 2: Prikaz podataka na radnom listu

- Otvorite datoteku 02_prikaz.xlsx

- Na prvom radnom listu podijelite prozor vodoravno i sakrijte prikaz zaglavlja
- Nadrugom radnom listu otkrijte prikaz prvog stupca.

- Na tre¢em radnom listu zamrznite zaglavlja tablice.

- Spremite promjene i zatvorite datoteku.

Vjezba 3: Vrednovanje i nadziranje podataka

- Otvorite datoteku 03_vrednovanje_podataka.xIsx
- Postavite kriterije valjanosti unosa podataka:
o naraspon Celija A1:A10 tako da mogu biti uneseni samo cijeli brojevi od 1 do 10
o naraspon celija B1:B10 tako da mogu biti uneseni samo decimalni brojevi veéi od
nule
o naraspon celija C1:C10 tako da mogu biti uneseni samo gradovi s popisa u stupcu H
- Unesite ulaznu poruku o valjanosti podataka za svaki raspon éelija koja glasi:
o A1:A10 - Unesite brojod 1 do 10.
o B1:B10 — Unesite decimalni broj veci od nule.
o C1:C10 - Unesite ime grada s popisa u stupcu H.
- Unesite poruku upozorenja o pogresci za svaki raspon celija koja glasi ,,Pokusajte
ponovno.” pa odaberite stil upozorenja:
o A1:A10 - Stani (Stop)
o B1:B10 - Upozorenje (Warning)
o C1:C10 - Informacija (Information)
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- Zajedan od 10 gradova u stupcu H umetnite komentar po izboru, npr. za Dubrovnik —
»omiljena destinacija“.
- Spremite promjene i zatvorite datoteku.

Vjezba 4: Napredna primjena funkcija i formula

- Otvoriti datoteku 04_funkcije.xlsx

- Naradnom listu statisticke izraCunati traZzene vrijednosti primjenom funkcija SUMIF |
COUNTIF. Pripazite pri kopiranju formule na primjenu mjesovitih adresa (broj redaka pri
kopiranju se ne mijenja)

- Naradnom listu reference pomocu funkcije pretrazivanja VLOOKUP izdvojite cijenu i
koli¢inu voéa prema zadanoj Sifri te izracunajte ukupnu vrijednost tog proizvoda.

- Otvorite radni list baze_podataka i primjenom odgovarajuéih funkcija baze podataka
odredite:

Ukupnu koli¢inu jabuka kojima je cijena manja od 5 KM?

Koliko ima vrsta jabuka s ciienom manjom od 5 KM?

Koja je prosjecna cijena jabuka koje se nalaze na skladistu?

Koja je najniza cijena jabuka?

O O O O O

Koja je najvisa cijena jabuka?
- Spremite promjene i zatvorite datoteku.

Viezba 5: Nadziranje formula

- Otvoriti datoteku 05_nadziranje_formula.xlsx

- Naradnom listu reference ucinite sve formule vidljivim na radnom listu.

- Naradnom listu baze_podataka prikazite od ¢ega ovisi izra¢un vrijednosti u ¢eliji 11.
- Spremite promjene i zatvorite datoteku.

Vjezba 6: Primjena sortiranja po vise kriterija

- Otvoriti datoteku 06_sortiranje.xlsx

- Sortirati podatke prema godini u padajuéem redoslijedu (od veéeg ka manjem), pa onda
prema regiji u rastu¢em redoslijedu (od A do Z).

- Spremite promjene i zatvorite datoteku.

Vjezba 7: Primjena naprednog filtriranja

- Otvoriti datoteku 07_filtriranje.xlsx

- Naradnom listu filtriranje ukljucite automatsko filtriranje podataka. PrikaZite sav uvoz i
izvoz za regiju Juzna Amerika u godini 1987.

- Naradnom listu napredno_{filtriranje u ¢eliju G1 izdvojiti podatke prema zadanim
kriterijima (godina 1989, uvoz izmedu 10000 i 30000)

- Spremite promjene i zatvorite datoteku.
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Viezba 8: Subtotali

- Otvoriti datoteku 08_subtotali.xIsx

- Naradnom listu subtotall prikazite pomodu subtotala (podzbrojeva) ukupan IZNOS
uvoza i izvoza ZA SVAKU GODINU.

- Naradnom listu subtotal2 prikaZite pomodu subtotala (podzbrojeva) ukupan PROSJEK
uvoza i izvoza ZA SVAKU REGIJU.

- Spremite promjene i zatvorite datoteku.

Vjezba 9: Izrada Pivot (zaokretne) tablice

- Otvoriti datoteku 09_pivot.xlsx

- Naradnom listu kreirati zaokretnu tablicu tako da su nazivi redaka — godine, vrijednosti
koje se analiziraju su 'uvoz'i 'izvoz', a filtri za izvje$ca su 'regije' i 'mjeseci'.

- Analizirati tablicu s razlic¢itim pretragama

- Spremiti promjene i zatvoriti datoteku.

Vjezba 10: Kombinirani grafikon

- Otvoriti datoteku 10_grafikoni.xlsx

- Za prikazanu tablicu na prvom radnom listu kreirajte stupcasti grafikon.

- Grafikon uredite tako da se na horizontalnoj osi nalaze nazivi mjeseci.

- Napravite kombinirani grafikon tako da niz podataka Ukupno prikaZete linijski.
- Dodati sekundarnu okomitu os za niz Ukupno.

- Postavite naslov grafikona ,,Prodaja pica u prvih Sest mjeseci” iznad grafikona.
- Spremite promjene i zatvorite datoteku.
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